iQue® M3

integrated handheld

operating instructions
Lithium-Ion Battery Information

Your iQue® M3 contains a non-user-replaceable lithium-ion battery. Please observe the following cautions:

- Do not store or use the unit in temperatures above 50°C (122°F) or below 0°C (32°F). Do not store or use the unit near a heat source, such as a radiator, stove, or fireplace. If heated, the battery in the unit could explode or vent, posing a risk of fire.

- Do not use any chargers not specified by Garmin. Do not charge the battery under conditions not specified by Garmin, as it may leak electrolytes, become hot, or explode.

- Do not put the unit into a fire, as it may swell or explode. Do not use near any type of heat source. If the battery leaks electrolytes or emits a strange smell, discontinue use and move the unit away from the heat source.

- Do not submerge the unit in water or any type of liquid. Do not expose the unit to any type of water, such as rain or moisture, as it might corrode, become hot, or occasionally not function.

- Keep the unit out of reach of babies and children.

- Do not put the unit in a microwave oven or pressure cooker.

- If you experience any problems with the battery, keep the unit in a safe place and immediately contact Garmin.

- If you must dispose of the unit, contact your local waste disposal department for information on properly disposing of lithium-ion batteries.
## TABLE OF CONTENTS

**Chapter 1: Getting Started**
- Parts of the iQue M3 ........................................ 1
- Resetting the iQue M3 ......................................... 3
- Opening Programs ............................................. 4
- Entering Information ......................................... 6
- Finding Information .......................................... 8
- Organizing Information ...................................... 8

**Chapter 2: Using ActiveSync**
- Choosing What Data to Synchronize .................... 9
- Choosing When to Synchronize ............................. 10
- Moving Files .................................................. 10
- Adding and Removing Programs ......................... 11
- Backing Up Files and Settings ............................ 13
- Synchronizing with an Exchange Server ............... 14
- Synchronizing Remotely with Infrared ................. 14

**Chapter 3: Pocket Outlook**
- Calendar: Scheduling Appointments and Meetings .... 15
- Contacts: Tracking Friends and Colleagues .......... 17
- Messaging: Sending and Receiving E-mail .......... 18
- Tasks: Keeping a To Do List ............................... 20
- Notes: Capturing Thoughts and Ideas ................ 21

**Chapter 4: Additional Programs**
- Pocket Word .................................................. 23
- Pocket Excel .................................................. 25
- Pocket Internet Explorer ................................... 26
- MSN Messenger .............................................. 28
- Windows Media Player for Pocket PC .................. 30
- Pictures ....................................................... 30

**Chapter 5: Getting Connected**
- Connecting to the Internet from a Modem .......... 32
- Connecting to a Network .................................. 36
- Exchanging Data with Mobile Devices ............... 39

**Chapter 6: Customizing Your iQue M3**
- Changing Personal Settings .............................. 40
- Viewing iQue M3 Information ............................ 43
- Configuring Backlight and Power Settings .......... 44
- Changing System Settings ................................. 45

**Appendix**
- About QueGPS ............................................... 48
- Troubleshooting ............................................... 48
- Learning About GPS and WAAS ....................... 49
- Caring for the iQue M3 ..................................... 49
- Storing the iQue M3 ......................................... 49
- Specifications ................................................ 50
- Software License Agreement ............................ 51

**Index** .......................................................... 53
CHAPTER 1: GETTING STARTED

Congratulations on purchasing an iQue® M3! Using your new iQue, you can keep your most important business and personal information up-to-date and close at hand. Microsoft® ActiveSync® increases the power of your device by allowing you to synchronize the information on your desktop or laptop computer with your device.

Parts of the iQue M3
Buttons

Use the buttons to open programs and perform actions. To change how a button behaves or which program it opens, see page 40.

- **Power**—press and release to turn the device on or off. Press and hold to turn the backlight on or off.
- **REC**—press to open the Notes program. Press and hold to record a message. Release to stop recording. See page 22.
- **Calendar**—press to open the Calendar program. See page 15.
- **Contacts**—press to open the Contacts program. See page 17.
- **Scroll**—press up, down, left, or right to highlight selections, scroll through pages, and move through lists. Press the center button to select highlighted options.
- **Messaging**—press to open the Messaging program. See page 18.
- **Que**—press to open the Que program. See the Quick Reference Guide for more information.
- **Reset**—press with the stylus to reset your device. See page 3.

LEDs

The Charging/Notification LED light at the top of your device flashes and changes color:

- **Solid Amber**—your device is charging.
- **Solid Green**—your device has finished charging.
- **Flashing Green**—your device is notifying you of an event or an alarm. See page 16.
- **Flashing Amber**—your device is in GPS Standby mode. In GPS Standby mode, the screen is turned off but the system remains on because the GPS antenna is still open. To save battery power, close your GPS antenna when not in use.

Using the Stylus

On your device, use the stylus to select items just as you would use a mouse on your personal computer. To remove the stylus, push up on the head of the stylus and lift it from the top of the device.

- **Tap**—touch the screen once with the stylus to open items and select options.
- **Drag**—hold the stylus on the screen and drag it across the screen to select text and images. Drag the stylus in a list to select multiple items. If you select an item by accident, drag the stylus away from the item to deselect.
- **Tap and Hold**—tap and hold the stylus on an item to see a pop-up menu for that item. A blue circle of dots appears where you are tapping on the screen. When the menu appears, lift the stylus and tap a menu item. Tap anywhere outside the menu to close it without selecting anything. The items in pop-up menus vary from program to program.

**NOTE:** Pop-up menus are disabled in QueNav. You cannot tap and hold with the stylus to access features on any QueNav page.
Resetting the iQue M3

You may need to reset your device if it stops responding to stylus taps or button presses or if it stops functioning normally. A “soft” reset is much like rebooting your personal computer.

**To reset your device (soft):**

Use the stylus to press and quickly release the Reset button on the bottom of your device.

A “hard” reset erases all entries, records, and settings in your device (erases all data stored in RAM).

**IMPORTANT:** Use a hard reset only if your device malfunctions severely or if a soft reset does not correct your problem.

**To reset your device (hard):**

1. Press and hold the REC and Contacts buttons while you press the Reset button with the stylus.
2. Release the Reset button first. Then release the REC and Contact buttons. A blue screen appears asking “Delete all your programs, data, and settings in memory?”
3. Press the Que button to select Yes or the Calendar button to select No. If you select Yes, another question appears: “Also delete all your permanent storage?” Select Yes to delete contacts, appointments, and other PIM data. The iQue M3 resets itself.

If other reset methods fail, use the stylus to press and hold the Reset button for approximately 8 seconds. Your device turns on automatically after you release the Reset button and starts as normal. This method of resetting automatically deletes all user data.

The Today Screen

When you turn on your device for the first time each day, the Today screen appears. You can also display it by tapping Windows (Start) and then Today. On the Today screen, you can see important information for the day at a glance.
Opening Programs

To open any program, you can select it from the Start menu by tapping Programs. When the menu appears, tap the name of the program you want to open. To access some programs, you need to tap Programs, and then the program name. To change the programs that appear in the Start menu, see page 41. To close a program or window, tap or in the top right corner of the screen. You can have several programs open at one time.

You can also open some programs directly from the Today screen or by pressing buttons on your device.

The following table contains a partial list of programs installed on your iQue M3. You can install additional applications at http://www.microsoft.com/windowsmobile.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Program</th>
<th>What You Can Do</th>
</tr>
</thead>
<tbody>
<tr>
<td>📡</td>
<td>ActiveSync</td>
<td>Synchronize information between your iQue M3 and desktop computer.</td>
</tr>
<tr>
<td>📞</td>
<td>Calculator</td>
<td>Perform basic arithmetic and computations.</td>
</tr>
<tr>
<td>📅</td>
<td>Calendar</td>
<td>Keep track of your appointments and create meeting requests.</td>
</tr>
<tr>
<td>📞</td>
<td>Contacts</td>
<td>Keep track of your friends and colleagues.</td>
</tr>
<tr>
<td>📩</td>
<td>Messaging</td>
<td>Send and receive e-mail messages.</td>
</tr>
<tr>
<td>📩</td>
<td>MSN Messenger</td>
<td>Send and receive instant messages with your MSN Messenger contacts.</td>
</tr>
<tr>
<td>📜</td>
<td>Notes</td>
<td>Create handwritten or typed notes, drawings, and recordings.</td>
</tr>
<tr>
<td>📈</td>
<td>Pocket Excel</td>
<td>Create new workbooks or view and edit Excel workbooks created on your desktop computer.</td>
</tr>
<tr>
<td>🌐</td>
<td>Pocket Internet Explorer</td>
<td>Browse Web and WAP sites and download new programs and files from the Internet.</td>
</tr>
<tr>
<td>📝</td>
<td>Pocket Word</td>
<td>Create new documents or view and edit Word documents created on your desktop computer.</td>
</tr>
<tr>
<td>🌐</td>
<td>QueNav</td>
<td>View your current position on the map, create and save locations in memory, and navigate routes.</td>
</tr>
<tr>
<td>📚</td>
<td>Tasks</td>
<td>Keep track of your tasks.</td>
</tr>
<tr>
<td>🎧</td>
<td>Windows Media Player 10</td>
<td>Play multimedia content (videos and sound files).</td>
</tr>
</tbody>
</table>
Navigation Bar and Command Bar

The Navigation Bar is located at the top of the screen. It displays the active program and current time. From the Navigation Bar, you can open and close programs, open the System Status window, check your connectivity, and change the volume of sounds.

In programs, use the Command Bar at the bottom of the screen to perform tasks. The Command Bar includes menu names, buttons, and the Input Panel button. To create a new item in the current program, tap New. To open a menu or see the action that a button performs, tap and hold the stylus on the button. If you do not want to activate the button, simply tap anywhere outside the menu or drag the stylus away from the button.

System Status Window

The System Status window provides you with information about your device’s GPS status, backlight, power, and memory. It also displays a list of all the programs currently running on your device. To open the System Status window, tap the System Status icon located in the Navigation Bar.

GPS Status Icon—displays the status of your GPS connection. Tap this icon to access the QueGPS™ page. See page 48 for more information.

Backlight Icon—displays your current backlight setting. Tap this icon to adjust your backlight settings.

Power Icon—displays your remaining battery power. Tap this icon to adjust your power settings.

Memory Icon—displays your remaining memory space. Tap this icon to adjust your memory settings.

Running Programs—lists all programs currently running on your device. To access a program in the list, tap it. To close a program, tap and hold on it, then select Close This Program. To close all programs, tap and hold on any program in the list, then select Close All Programs.
Entering Information

Use the Input Panel to enter information in any program on your device. You can type using the soft keyboard or write using Letter Recognizer, Block Recognizer, or Transcriber. When using each Input Panel method, the characters appear as typed text on the screen.

To show or hide the Input Panel, tap the Input Panel button. Tap the arrow next to the Input Panel button to choose a method for entering text.

When you use the Input Panel, your device anticipates the word you are typing or writing and displays it above the Input Panel. When you tap the displayed word, it is inserted into your text at the blinking cursor. As you continue to use your device, it learns to anticipate more and more words.

With the soft keyboard, you can tap letters to enter information. Letter Recognizer allows you to write letters using the stylus just as you would on paper. With Block Recognizer you can input character strokes with the stylus that are similar to those used on other devices. Using Transcriber you can write anywhere on the screen with the stylus, just as you would on paper. Write a sentence or more of information, then pause and let Transcriber change the written characters to typed characters.

**To type with the soft keyboard:**
1. Tap the arrow next to the Input Panel button and then tap Keyboard.
2. On the soft keyboard that is displayed, tap the keyboard keys with your stylus.

**To write with Letter Recognizer:**
1. Tap the arrow next to the Input Panel button and then tap Letter Recognizer.
2. Write letters and numbers in the box just as you would write on paper.
To write with Block Recognizer:
1. Tap the arrow next to the Input Panel button and then tap Block Recognizer.
2. Write letters and numbers in the box.

To write with Transcriber:
1. Tap the arrow next to the Input Panel button and then tap Transcriber.
2. Write anywhere on the screen.

Editing Text
If you want to edit or format typed text, you must select it first. Simply drag the stylus across the text you want to select. You can cut, copy, or paste text by tapping and holding the selected words and then tapping the appropriate command on the pop-up menu. You can also use the Edit menu.

Entering Dates
Many applications ask you to enter a date, such as “September 6, 2007.” All standard Windows Mobile™-based applications use the same form to assist in this process.

To enter dates:
1. Tap the date field you want to change.
2. Tap the left or right arrows at the top of the calendar to move between months. You can also tap the month and choose a specific month from a menu.
3. Tap the year, and then tap the up and down arrows to change the year. You can also use the Input Panel to enter a year.
4. Tap the day on the calendar to select the date you want. Tap Today to choose today’s date.
Finding Information

The Find program on your device helps you locate information quickly. Use it to find folders or files, especially large files that may be taking up needed space.

To find files, folders, or text:
1. Tap Programs, and then Find.
2. Tap the Find field and enter the name of the file or folder or the text you want to find.
3. Tap the Type drop-down menu and select the type of file you are searching for.

   **NOTE:** If you are trying to find files or folders that are taking up storage space, choose Larger than 64 KB from the Type menu.

4. Tap Go. Search results appear. Tap any search result to open that file or folder. If no search results appear, broaden your search criteria and try again.

Organizing Information

You can easily move and organize files and folders with File Explorer. To open, tap Programs, and then File Explorer. Tap and hold to cut, copy, paste, rename, or delete files and folders.
CHAPTER 2: USING ACTIVESYNC

Using Microsoft® ActiveSync®, you can synchronize the information on your desktop computer with the information on your iQue M3. When you synchronize, ActiveSync compares the data on your iQue M3 with your desktop computer and updates both with the most recent information.

Use ActiveSync to manage the information stored on your iQue M3:

• Select the information types you want to synchronize and control how much data you synchronize.
• Control when synchronization happens.
• Copy (rather than synchronize) files between your device and desktop computer.
• Add or remove programs.
• Back up and restore data.
• Synchronize remotely or with an Exchange server.

You should have already installed ActiveSync on your desktop computer and synchronized for the first time. If you have not done this, refer to the Setup Guide included with the Companion DVD-ROM for instructions.

Choosing What Data to Synchronize

Because your iQue M3 has a limited amount of storage space, we recommend that you limit the amount of information you synchronize or store. For example, you can limit the number of Calendar appointments you synchronize between your desktop and your iQue M3 to save storage space. You can change these settings on your desktop computer.

To change what types of information to synchronize:
1. Open Microsoft ActiveSync on your desktop computer. Then click Options.
2. Click to check the box next to each type of information you want to share between your desktop computer and your iQue M3.
3. Click OK.

To limit how much information is synchronized:
1. From ActiveSync on your desktop computer, click Options.
2. Click Calendar in the list of programs. Then click Settings. Check options to limit how many appointments you synchronize. When finished, click OK.
3. Repeat for each type of information you synchronize.
4. Click OK.

Customize your ActiveSync settings by clicking Options.
Choosing When to Synchronize
You can control how often your device synchronizes information by changing settings in ActiveSync on your desktop computer.

To change when synchronization happens:
1. Open Microsoft ActiveSync on your desktop computer.
2. Click Options and then the Schedule tab.
3. Click to choose how often you would like to synchronize information. If you choose “Synchronize manually,” you must open ActiveSync and click Sync each time you want to synchronize data.
4. Click OK.

Moving Files
You may want to move files or folders between your desktop and your iQue M3 without having to synchronize that information. This method works well for files you do not need to update or for files that you cannot synchronize, like pictures. Moving files and folders onto your iQue M3 or SD card is just like moving them from one location to another on your personal computer. For more help, refer to your desktop computer Help files.

NOTE: You may have trouble transferring large files (> 50 MB) to your SD card. If so, you may need to use a separate data card reader, rather than transferring files directly to your SD card in your iQue M3.

To move files or folders:
1. Open ActiveSync on your desktop computer.
2. Click Explore. This window shows all files and folders stored on your iQue M3.
3. To move files to your iQue M3, click and drag files or folders from your desktop computer to this window. You can also Cut, Copy, and Paste to move files.
4. To move files to your desktop computer, click and drag files or folders from this window to your desktop computer. You can also Cut, Copy, and Paste.

NOTE: ActiveSync may need to convert files when synchronizing between your mobile device and the desktop computer. A converted file may not contain all the information found in the original file.
Adding and Removing Programs

Programs added to your iQue M3 at the factory are stored in read-only memory (ROM). You cannot remove this software, and you will never accidentally lose ROM contents. All other programs and data files added to your device after factory installation are stored in random access memory (RAM).

You can install any program created for Pocket PC devices with ARM processors, as long as your iQue M3 has enough memory to store the program.

To add programs:
1. Be sure the program is compatible with your iQue M3 (ARM processor).
2. Download the program to your desktop computer (or insert the disk that contains the program into your desktop computer). You may see a single *.cab, *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to select the program designed for ARM devices.
3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.
4. Connect your device to your desktop computer.
5. Double-click the setup file.
   • If the file is an installer, the installation wizard begins. Follow the directions on the screen. After the software has been installed on your desktop computer, the installer will automatically transfer the software to your device.
   • If the file is not an installer, an error message appears, stating that the program is valid but it is designed for a different type of computer. You must move this file to your device. See page 10.
6. Once installation is complete, tap Programs, and then the program icon to open. You may need to browse for the file in order to open it on your device. To add the program to the Start menu, see page 41.

To add programs directly from the Internet:
1. Open Pocket Internet Explorer on your iQue M3 and connect to the Internet to search for programs you want to download. For more information, see page 32.
2. After you find a program, download it to your iQue M3. You may see a single *.xip, *.exe, or *.zip file, a Setup.exe file, or several versions of files for different device types and processors. Be sure to select the program designed for ARM processors.
3. Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide special installation instructions.
4. Tap the setup file. The installation wizard begins. Follow the directions on the screen.
To add programs to your Start menu from ActiveSync:
1. Open ActiveSync on your desktop computer.
2. Click Explore.
3. Locate the program file. Right click on the program file name and click Create Shortcut.

To add programs to your Start menu from your iQue M3:
1. Tap and then Settings.
2. Tap the System tab. Then tap Menus.
3. Tap to check the items you want to include in the Start menu. Unchecked items appear in the Programs menu.

NOTE: This method of adding programs only works if a shortcut to the program already appears in the Programs folder.
To add programs to the Start menu that do not appear in the list, follow the instructions below.

1. Tap Programs, and then File Explorer.
2. From the pull-down menu, select My Device to view all files and folders on your iQue M3. Locate the program file.
3. Tap and hold on the program file and choose Cut from the pop-up menu.
4. From My Device, tap the Windows folder and then the Start Menu folder. Tap and hold on a blank area inside this folder and choose Paste from the pop-up menu.

To remove programs with ActiveSync:
1. Launch ActiveSync on your desktop computer.
2. From the Tools menu, select Add/Remove Programs.
3. Highlight the name of the program you want to remove from your iQue M3.
4. Click Remove.
5. Follow the on-screen instructions.

To remove programs from your iQue M3:
1. Tap Settings, the System tab, and then Remove Programs.
2. Tap to highlight the program you want to remove; then tap Remove.

NOTE: If the program does not appear in the list of installed programs, use File Explorer on your device to locate the program, tap and hold the program, and then tap Delete on the pop-up menu.
Backing Up Files and Settings
It is important to back up your iQue M3 files and settings periodically. When you back up files with ActiveSync, you will store an “image” of the files, folders, and settings on your iQue M3. Then, if you lose data for some reason, you can restore your iQue to the last image you saved.

To back up files and settings:
1. Open ActiveSync on your desktop computer.
2. From the Tools menu, choose Backup/Restore.
3. Choose whether you want to do a full backup (saves all information) or an incremental backup (saves any information that has changed since last backup).
4. Choose where you want to save the backup file. If you want to back up your iQue M3 each time you synchronize, check the box next to “Automatically back up each time the device connects.”
5. Click Back Up Now.

**NOTE:** Do not use your iQue M3 before you are finished backing up files. If you do, the backup process may fail.

To restore your iQue M3 to the last backup state:
1. Open ActiveSync on your desktop computer.
2. From the Tools menu, choose Backup/Restore. Click the Restore tab.
3. Click Restore Now.

**NOTE:** Any information that has changed on your iQue M3 since your last backup will be erased by the restore process.
Synchronizing with an Exchange Server

If your company has installed Microsoft Exchange Server with Exchange Server ActiveSync, you can synchronize between your iQue M3 and a server. Note that you can only synchronize with a server or with your desktop computer, not both.

For more information on setting up and synchronizing with an Exchange server, refer to the ActiveSync Help files on your desktop computer (with ActiveSync open, press F1 on your keyboard or choose Microsoft ActiveSync Help from the Help menu).

Synchronizing Remotely with Infrared

If you have a desktop or laptop with an Infrared (IR) port, you can synchronize remotely with IR. Make sure the IR ports on your computer and your iQue M3 are lined up with no objects between them.

To synchronize remotely with IR:

1. Tap and then ActiveSync on your iQue M3.
2. Tap Tools and then Connect via IR. ActiveSync connects automatically.
CHAPTER 3: POCKET OUTLOOK

Microsoft® Pocket Outlook includes Calendar, Contacts, Tasks, Messaging, and Notes. You can use these programs individually or together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Messaging.

Using ActiveSync®, you can synchronize information in Microsoft Outlook® or Microsoft Exchange on your desktop computer with your device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you synchronize, ActiveSync compares the changes you made on your device and desktop computer or server and updates both with the latest information. For information on using ActiveSync, see Chapter 2, beginning on page 9.

You can switch to any of these programs by tapping and then Programs.

Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. To open Calendar, press the Calendar button on the front of your iQue M3, or tap and then Calendar. You can check your appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily switch views by tapping the icons below:

<table>
<thead>
<tr>
<th>Agenda View</th>
<th>View all appointments for the day in list form; upcoming appointments are bold.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day View</td>
<td>View your day’s schedule in one-hour blocks.</td>
</tr>
<tr>
<td>Week View</td>
<td>View your week’s schedule in one-hour blocks.</td>
</tr>
<tr>
<td>Month View</td>
<td>View which days of the month contain scheduled appointments.</td>
</tr>
<tr>
<td>Year View</td>
<td>View a year calendar.</td>
</tr>
</tbody>
</table>

To create an appointment:
1. If you are in Day or Week View, tap the date and time for the appointment.
2. Tap New.

---

![Calendar View](Image)
3. Tap to select a field. Then enter a description and a location using the Input Panel.
4. If needed, tap the date and time to change them.
5. Enter other information as needed. You will need to hide the Input Panel or use the scroll bar to see all available fields. (Tap \[Hide\] to hide the Input Panel.)
6. If this appointment occurs more than once, tap the \textbf{Occurs} field and select a drop-down option.
7. To add notes, tap the \textbf{Notes} tab. See page 21 for more information.
8. To set an appointment reminder, tap the \textbf{Reminder} field. Tap to change the time when the reminder will appear.
9. When finished, tap \[OK\] to return to the calendar.

**Using the Summary Screen**

When you tap an appointment in Calendar, a summary screen appears. To change the appointment, tap \textbf{Edit}. To beam an appointment, tap and hold on the appointment and then select \textbf{Beam Appointment}.

![Appointment Summary Screen](image)

**Creating Meeting Requests**

You can use Calendar to set up meetings with Outlook or Pocket Outlook users. When you set up a meeting, an e-mail meeting request is created automatically and sent either when you synchronize your Inbox or when you connect to your e-mail server. Tap \textbf{Tools} and then \textbf{Options} to indicate how you want to send meeting requests.

\textbf{To schedule a meeting:}
1. Create an appointment.
2. In the appointment details, hide the Input Panel \[Hide\] or use the scrollbar and then tap the \textbf{Attendees} field.
3. From the list of e-mail addresses you have entered in Contacts, select the meeting attendees. Then tap \[OK\]. The meeting notice is created automatically and placed in the \textbf{Outbox} folder of your Inbox. See page 18 for more information.

**Notifications**

Your iQue M3 helps you remember appointments and tasks in a variety of ways. You may see or hear any of the following notifications:

- A message box that appears on the screen.
- A sound (which you can specify).
- A flashing light on the upper right-hand corner of the iQue M3.

See “To change notifications” on page 42 to change the way your iQue M3 notifies you of upcoming events.
Contacts: Tracking Friends and Colleagues

Use Contacts to store contact information for your friends and colleagues. Using your iQue M3 infrared (IR) port, you can quickly share Contacts information with other device users. You can also integrate your Contacts list with your Locations list in QueNav (for more information, refer to the Quick Reference Guide or the Help files on the iQue M3). To open Contacts, press the Contacts button on your iQue M3, or tap 📞 and then Contacts.

To create a contact:
1. Open Contacts and tap New.
2. Using the Input Panel, enter a name and other contact information. Scroll down to see all available fields.
3. To assign the contact to a category, tap Categories and select a category from the list.
4. To add notes, tap the Notes tab. See page 21 for more information.
5. Tap 🔄 to return to the contact list.

To find a contact:
1. From the Contacts page, enter all or part of a contact name in the Find a name field.
2. Tap a contact in the list to view a summary screen. To edit information, tap Edit. To beam a contact, tap and hold on the contact and select Beam Contact. To show all contacts again, clear the text from the Find a name field or tap the button to the right of the field.
Messaging: Sending and Receiving E-mail

Use Messaging to send and receive e-mail in either of these ways:

- Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
- Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a network.

To open Messaging, press the Messaging button on the front of your iQue M3, or tap and then Messaging.

Using Messaging

From the main Messaging screen, compose a new message by tapping New. Tap the Inbox drop-down menu to see an expandable list of your Messaging folders. Here you can find messages waiting to be sent, messages you have already sent, and deleted messages.

**NOTE:** It’s a good idea to clear your Deleted Items folder manually from time to time to save storage space. Open your Deleted Items folder; tap and hold on each message, and choose Delete from the pop-up menu.

Tap the Sort by drop-down menu (located to the right of the Inbox drop-down menu) to change the listed order of your messages. Tap a message to view the message. Tap and hold a message to reply, forward, delete, or move the message.

Using Signatures

A signature is a few lines of text that is automatically included at the bottom of each e-mail you send. Each account can have its own signature.

**To create a signature:**
1. Tap Accounts and then Accounts....
2. Tap the Signatures button.
3. Choose an account from the Select an account drop-down menu that you want to apply the signature to.
4. Check the box next to Use signature with this account. Check the box if you want to include the signature when you reply or forward a message.
5. Enter the signature text.
6. To create signatures for other accounts, choose another account from the drop-down menu.
7. Tap ok.

Creating a new signature.
Saving vCard (.VCF) Attachments

vCards are electronic business cards—a powerful new means of Personal Data Interchange (PDI) and a way to automate the traditional business card. Using vCards with Pocket PC is easy: when you receive these files as e-mail attachments, simply save them to your Contacts database.

To save vCards as Contacts:
1. Open an e-mail with a vCard attachment (.vcf) and tap the attachment.
2. Tap Yes to save the contact to your Contacts database.

Synchronizing E-mail Messages

E-mail messages can be synchronized as part of the general synchronization process. You need to enable Inbox synchronization in ActiveSync. For information on enabling Inbox synchronization, see page 9.

During synchronization, messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox on your device. By default, you will receive messages from the past three days only, the first 100 lines of each message, and file attachments of less than 100 KB in size. E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those programs. E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in order to be transferred.

Connecting Directly to an E-mail Server

In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by connecting to an e-mail server. To connect, you must set up a remote connection to a network or an ISP. For more information, see page 32. When you connect to the e-mail server, new messages are downloaded to your Inbox folder, messages in the device Outbox folder are sent, and messages that have been deleted from the e-mail server are removed from your Inbox folder. Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. When you delete a message on your iQue M3, it will also be deleted from the e-mail server the next time you synchronize. You can connect to one e-mail server or several. Before you connect, specify which server you want to connect to.

To connect directly to an e-mail server:
1. Tap Accounts and then New Account....
2. Enter your e-mail address and tap Next. Messaging tries to configure your e-mail settings automatically based on your e-mail address.
3. Enter your name, account user name, and account password. Check Save Password if you want this password to be saved for future connections. Tap Next.
4. Choose whether this account is POP3 or IMAP4 (IMAP4 should be used for standard IMAP and Exchange Server accounts). Enter a name for this account. Tap Next.
5. Enter your incoming and outgoing mail servers and the domain name if applicable. Consult your IT department for this information. Tap Options to customize your account settings.

To configure existing e-mail accounts:
1. Tap Accounts and then Accounts.... Then tap an account from the list of existing accounts. The account wizard opens.
2. Make changes (if you wish) and tap Next until you reach the mail servers page. Tap Options.
3. Choose how often you want to connect to your server and download new messages. Choose whether you want to use your Internet profile or your Work profile to connect. Tap Next. For more information on connecting, see Chapter 5, beginning on page 32.
4. Choose whether your outgoing mail server requires authentication, whether you want to use secure connections, and how many messages you want to display. Tap Next.
5. Choose how many of your mail messages you want to download. Tap Finish.
Tasks: Keeping a To Do List

Use Tasks to keep track of what you have to do. To open Tasks, tap Programs, and then Tasks.

To create a task:
1. Open Tasks and tap New.
2. Using the Input Panel, enter a description.
3. Tap other fields to enter a start date and due date or other information. If the Input Panel is open, hide it or use the scrollbar to see all available fields.
4. To assign the task to a category, tap Categories and select a category from the list.
5. To add notes, tap the Notes tab. See page 21 for more information.
6. Tap to return to the task list.

To create a task with only a subject line:
1. Tap Tools and make sure a check mark appears next to Entry Bar. If not, tap Entry Bar.
2. To make the new task high priority, tap . To make the new task low priority, tap . Then tap the entry bar (the field above the task list) and enter a title for your new task.
3. Tap the Enter key on the keyboard to add the task to your task list.

Using the Summary Screen

When you tap a task in the task list, a summary screen appears. To change the task, tap Edit. To beam the task, tap and hold on the task name and select Beam Task.
Notes: Capturing Thoughts and Ideas

Quickly capture thoughts, reminders, ideas, drawings, and recordings with Notes. To open Notes, tap the Notes icon on the Shortcuts bar, located on the Today screen. You can also tap Programs, and then Notes. To beam a note, tap and hold on the name of a note in the Notes list. Then select Beam File from the drop-down menu.

To create a note:
1. Open Notes and tap New.
2. Add text to your note using one of the input methods. If you wish, add drawing or handwriting to your note with the drawing button on the toolbar.
3. Add voice recording to your note by tapping the Record button on the toolbar.
4. Tap OK. The note is saved automatically.

Creating a new note.

Writing on the Screen

In the Notes program and in the Notes tab in Calendar, Contacts, and Tasks, you can use your stylus to write directly on the screen. Write the way you do on paper. You can edit and format what you have written and convert the information to text at a later time.

To write on the screen:
1. Tap the Pen icon to switch to writing mode.
2. Write anywhere on the screen.
3. To select and change writing, tap and hold the stylus next to the text you want to select until the cursor appears. Without lifting, drag the stylus across the text you want to select.

To convert writing to text:
1. Select the writing you want to convert to text. (This is necessary only if you wish to convert part of your writing rather than all of it.)
2. Tap Tools and then tap Recognize.
3. If the conversion is incorrect, tap and hold the incorrect word (tap one word at a time). From the pop-up menu, tap Alternates. Then tap the word you want to use, or tap the writing at the top of the menu to return to the original writing.

Try these tips for good recognition:
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and apostrophes below the top line so that they are not confused with the word above. Write periods and commas above the line.
• Try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word close together and leave big gaps between words so the device can easily tell where words begin and end.

• Note that hyphenated words, foreign words that use special characters such as accents, and some punctuation cannot be converted.

• Note that you cannot change words that have already been recognized by writing over them with the stylus.

**Drawing on the Screen**

You can draw on the screen in the same way that you write on the screen. The difference between writing and drawing on the screen is how you select items and how they can be edited. For example, selected drawings can be resized, whereas writing cannot.

To create a drawing, select the Pen icon and simply cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes inside or touching the drawing box become part of the drawing. Drawings that do not cross three ruled lines will be treated as writing.

**To edit a drawing:**
1. Tap and hold the stylus on the drawing until the selection handle (looks like a “+”) appears.
2. Drag the selection handle to select the drawing.
3. Tap and drag to move the drawing.
4. Tap the **Edit** menu or tap and hold on the drawing to cut, copy, or paste the drawing.

**Recording a Message**

You can record sounds inside a note as a stand-alone recording (if no notes are open), or as an embedded sound file inside a note. You can also create recordings in the Notes tab of Calendar, Contacts, and Tasks. In Messaging, you can add a recording to an e-mail message.

**To create a recording:**
1. Hold the microphone on your iQue M3 near your mouth or other source of sound.
2. Press and hold the REC hardware button on your device. When you hear a beep, begin recording (continue holding down the REC button).
3. To stop recording, release the REC button. The new recording appears in the note list or as an embedded icon.
4. To play a recording, tap it in the list or tap the embedded recording icon in the note.
CHAPTER 4: ADDITIONAL PROGRAMS

Your device contains several other programs designed to run on Pocket PC systems, many of which can integrate with programs on your desktop computer. Pocket Office on your iQue M3 includes Pocket Word and Pocket Excel. Other programs include Pocket Internet Explorer, Microsoft® MSN Messenger, Microsoft® Windows Media Player 10, and Pictures. For more help with any of these programs, refer to the Help files by tapping Help and then Help from within any program.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to your Word documents. Using ActiveSync, you can synchronize documents between your desktop computer and your iQue M3 so both have the most up-to-date document versions. To open Pocket Word, tap Programs, and then Pocket Word.

Using Pocket Word

You can create new documents in Pocket Word or open existing documents that you have transferred from your desktop computer. Pocket Word automatically saves each document when you tap to close it. You can also save a document by tapping Tools, File, and then Save Document As.

To create a new Pocket Word document:
1. Open Pocket Word by tapping Programs, and then Pocket Word.
2. If a blank document does not automatically appear, tap New.

You can open only one document at a time. When you open a second document, you are asked to save the first. You can save the document in a variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt).

You can change the zoom magnification by tapping View, Zoom, and then selecting the percentage you want. Select a higher percentage to enter text and a lower one to see more of your document. If you are opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can see the entire document without having to scroll from left to right.

On the main screen (no documents open), Pocket Word contains a list of the Pocket Word files stored on your iQue M3. Tap a file in the list to open it. To delete, copy, rename, move, send by e-mail, or beam a file, tap and hold on a file name in the list. Then select the appropriate action from the pop-up menu.
Input Modes in Word

When you are working with a document, the View menu allows you to switch between input modes. You have a choice of writing, drawing, typing, and recording modes, similar to Notes. To change modes, tap View and then tap one of the four modes.

Typing Mode

In Typing mode, use the Input Panel to enter typed text into the document. To format existing text and to edit text, first select the text. You can select text as you do in a Word document, using your stylus instead of the mouse to drag through the text you want to select. You can search for text in a document by tapping Edit and then Find/Replace.

Writing Mode

In Writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as guides, and the zoom magnification is greater than in typing mode to allow you to write more easily.

Remember, if you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, which can be edited and manipulated.

Drawing Mode

In Drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen after the first stroke, a drawing box appears indicating the boundaries of the drawing. Every stroke within or touching the drawing box becomes part of the drawing.

Recording Mode

In Recording mode, embed a recording into your document. Recordings are saved as *.wav files and appear as icons embedded in your document.
Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. With ActiveSync, you can synchronize workbooks between your desktop computer and your device so that you have the most up-to-date content in both locations. To open Pocket Excel, tap Programs, Programs, and then Pocket Excel.

Working with Pocket Excel

Use Pocket Excel to create spreadsheets, such as expense reports or mileage logs. Pocket Excel automatically saves each document when you tap to close it. You can also save a document by any name by tapping Tools, File, and then Save Workbook As.

To create a new Pocket Excel file:
1. Open Pocket Excel by tapping Programs, Programs, and then Pocket Excel.
2. Tap New to open a blank spreadsheet.

You can open only one file at a time. When you open a second file, you will be asked to save the first. You can save a spreadsheet you create or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, tap or tap View and then Toolbar.

For more information on using Pocket Excel, refer to the Microsoft Excel Help file on your desktop computer or to the Help file on your iQue M3 (tap Help to access).

On the main screen (no documents open), Pocket Excel contains a list of the Pocket Excel files stored on your iQue M3. Tap a file in the list to open it. To delete, copy, rename, move, send by e-mail, or beam a file, tap and hold on a file name in the list. Then select the appropriate action from the pop-up menu.
Pocket Internet Explorer

You can use Pocket Internet Explorer to browse mobile favorites and channels that have been stored on your iQue M3 without connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse the Internet. For more information on connecting to the Internet, see page 32.

To store mobile favorites or channels on your iQue M3:
1. From ActiveSync on your desktop computer, click Options.
2. Check the box next to Favorites to automatically synchronize mobile favorites.
3. In Internet Explorer on your desktop computer, browse to a page you want to view on your iQue M3.
4. From the Tools menu, click Create Mobile Favorite.
5. Synchronize your iQue M3 with your desktop computer.

To view mobile favorites and channels:
1. On your iQue M3, tap the Internet Explorer icon ☯ in the Shortcut bar.
2. Tap Favorites ☇ to display the list of favorites you have downloaded.
3. Tap the page you want to view. If a page in the list appears dimmed, it has not been downloaded to your iQue M3. You must synchronize with your desktop to download this page. You can also connect to the Internet directly.

To browse the Internet:
1. Set up a connection to your ISP or corporate network. See Chapter 5, beginning on page 32.
2. Tap the Internet Explorer icon ☯ in the QuickLaunch bar or tap ☇, Programs, Internet Explorer.
3. Tap Favorites ☇, and then tap the favorite you want to view.

OR

Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter the Web address you want to visit and then tap the Go icon ☯. Tap the down arrow to choose from previously entered addresses.
To create favorites directly from the Internet:
1. Open Internet Explorer and then open the page you want to save as a favorite.
2. Tap Favorites and then the Add/Delete tab.
3. Tap New Folder to create a new folder for your favorite. Enter the name and then tap Add.
4. Tap the folder where you want to add your favorite and tap Add.
5. Accept the suggested favorite name and URL or create your own. Tap Add.
6. Tap ok.

Displaying Images

By default, Web pages appear with images loaded. It is a good idea to turn off images when connected over a wireless Internet connection if you pay for each megabyte transferred—large images can be expensive to download. To turn off images, tap View and then Show Images.

When a Web site is loaded but with images hidden, image placeholders appear. To show individual images, tap and hold on the image and choose Show Picture.

Configuring Pocket Internet Explorer

Tap Tools and then Options to change the default home page by using the currently loaded page or the device default. Tap the Memory tab to choose how many days of history you want to save. Tap Clear History to remove past history information. On this tab, tap Delete Files to remove temporary cached files (such as Web pages and images) and free space on your device. Tap the Security tab to turn off cookies, clear cookies, and warn when changing to an insecure page.

**NOTE:** Some Web sites may not render properly if cookies have been disabled.
MSN Messenger

MSN® Messenger on your mobile device is an instant messaging program that lets you:

• See who is online.
• Send and receive instant messages.
• Have instant message conversations with groups of contacts.

To use MSN Messenger, you must have a Microsoft Passport™ account or a Microsoft Exchange e-mail account. You must have a Passport to use MSN Messenger Service. If you have a Hotmail® or MSN account, you already have a Passport. Sign up for a Microsoft Passport account at http://www.passport.com. Get a free Microsoft Hotmail e-mail address at http://www.hotmail.com. Once you have obtained either a Microsoft Passport or a Microsoft Exchange account, you are ready to use MSN Messenger. To open MSN Messenger, tap Programs, and then MSN Messenger.

To set up an account and sign in:

1. Launch MSN Messenger. Make sure you are connected to the Internet (see Chapter 5, beginning on page 32, for details).
2. Select Tools > Options and select the Account tab.
3. Enter your Passport or Exchange account information. Be sure to indicate which service you wish to connect with.
4. To sign in, tap the sign-in screen and enter your e-mail address and password.

Signing in to MSN Messenger

NOTE: In future connections, your information will be already entered in the MSN login screen.

At any time, you can select Tools > Sign Out to disconnect your session. To sign in when disconnected, you can tap the screen or you can tap Tools and then Sign In.
Working with MSN Messenger Contacts

The MSN Messenger window shows all of your messenger contacts at a glance, divided into Online and Not Online categories. From this view, you can chat, send an e-mail, block a contact from chatting with you, or delete contacts from your list using the pop-up menu.

To add a contact:
1. Tap Tools and then Add a Contact.
2. Enter the name of the user you want to add and tap Next.

To chat with a contact:
1. Tap a contact name to open a chat window.
2. Enter your message in the text entry area at the bottom of the screen, and tap Send.

NOTE: To switch back to the main window without closing a chat, tap . To revert back to your chat window, tap Chats and select the person with whom you were chatting.

Using My Text

When you are using MSN Messenger, you can use My Text to insert frequently-used words or phrases into the text entry area. To insert a message, tap My Text and tap a message. You can add text after inserting a My Text message before sending it.

To edit a My Text message, tap Tools and then Edit My Text. Select the message you wish to edit and make desired changes. Tap to save changes.

Chatting Tips

Keep these tips in mind when you are chatting with contacts:

• To know if the contact you are chatting with is responding, look for the message under the text entry area.
• If the other chat participants are not entering text, the date and time of the last message received appears at the bottom of the screen.
• To change how you appear to other users, from either the main Messenger window or a chat window, select Tools > My Status. These same choices appear in MSN/Windows Messenger.
• To jump to chats you have active with other users, select Chats and highlight the appropriate contact’s name.
Windows Media Player for Pocket PC

Use Microsoft Windows Media Player for Pocket PC to play digital audio and video files, including any Windows Media or MP3 file formats (.asf, .wma, .wmv, .mp3). To open Windows Media Player for Pocket PC, tap the Windows Media icon in the Shortcut bar on the Today screen, or tap Programs, and then Windows Media.

Media Playback

Once you have loaded a media file, you can play, pause, stop, song advance/reverse, mute sound, or adjust volume. Tap the full-screen mode button to hide the toolbars and show the media in landscape mode. (To return to normal play mode, tap the screen again.)

Pictures

Use Pictures to view JPEG pictures stored on your device or in a storage card, send pictures to others, view a slideshow of your pictures, or set a picture as the background on the Today screen. You can even set Pictures to launch itself when a digital camera storage card is inserted into your device.

To open, tap Programs, and then Pictures. By tapping and holding on a picture file, you can copy, delete, beam, rename, or send the file via e-mail.

To open Pictures when an SD card is inserted:
1. From within Pictures, tap Tools and then Options.
2. Check the box next to “Detect digital camera storage cards.”
Working with Images

When you open Pictures, a list of all image files in the My Pictures folder of your iQue M3 appears. You can view files on an SD card or in Safe Storage by tapping the My Pictures drop-down menu. To view a picture, tap the thumbnail of the picture. Then you can rotate, crop, zoom, share, or change brightness and contrast levels of the picture.

When making changes, you can tap Edit > Undo or Edit > Redo to undo or redo the last change made. To undo many changes at once, tap Tools and then Revert to Saved; this step discards all changes since the last save. After you are finished making changes, tap Save Picture As in the Tools menu. Keep in mind that the quality of the image may decrease after saving.

You can use a picture to replace the current background, or wallpaper, on the Today screen.

To set an image as Today wallpaper:
1. Tap Tools and then Set as Today Wallpaper. Pictures automatically crops and resizes the picture to fit the Today screen.
2. Select a transparency level. If you have trouble reading text on your Today screen, make the image more transparent (set the transparency to a larger percentage).

**NOTE:** An improperly sized image appears distorted when applied as wallpaper on the Today screen.

To view images in a slideshow:
1. From the main Pictures window, tap the Slideshow icon.
2. To advance the slideshow, tap anywhere on the screen.
3. To change from vertical to horizontal viewing mode, tap the Flip view icon.

**NOTE:** You can change the slideshow settings by tapping Tools, Options, and then the Slide Show tab.
CHAPTER 5: GETTING CONNECTED

You can use your iQue M3 to exchange information with the Internet, with a network, or with other mobile devices. You have the following connection options:

- Connect to the Internet through your Internet service provider (ISP). Once connected, you can send and receive e-mail messages by using Messaging and view Web or WAP pages by using Microsoft® Pocket Internet Explorer. See “Connecting to the Internet from a Modem” below.
- Connect to the network at your company or organization where you work. Once connected, you can send and receive e-mail messages by using Messaging, view Web or WAP by using Pocket Internet Explorer, and synchronize with your desktop computer. See “Connecting to a Network” on page 36.
- Connect using Infrared (IR) to any other device that uses these technologies. See page 39.

For information on how to connect and exchange information with your desktop computer, see Chapter 2, beginning on page 9.

You can determine the status of your connection from the connectivity icons, which appear in the notification area. Note that some of these icons are animated.

<table>
<thead>
<tr>
<th>Status Icon</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>🔄</td>
<td>Connected</td>
</tr>
<tr>
<td>🔄 or 🔄</td>
<td>Transferring Data</td>
</tr>
<tr>
<td>🔄</td>
<td>Not Connected</td>
</tr>
<tr>
<td>🔄</td>
<td>Synchronizing</td>
</tr>
<tr>
<td>🔄</td>
<td>Zero–Configuration Internet (The Internet connection has not been configured yet.)</td>
</tr>
</tbody>
</table>

Connecting to the Internet from a Modem

To set up a modem connection to your ISP, you need the following information:

- ISP dial-up access telephone number.
- User name. Some ISPs require information in front of the user name, such as “MSN/username.”
- Password.
- TCP/IP settings.
To set up a modem connection to an ISP:
1. Tap \( \text{Start} \) and then \( \text{Settings} \).
2. In the \textbf{Connections} tab, tap the \textbf{Connections} icon.
3. Under \textbf{My ISP}, tap \textbf{Add a new modem connection}.

![Image of Settings screen with Connections tab highlighted]

4. Enter a name for the connection, such as “My ISP.”
5. In the \textit{Select a modem} list, select your modem type. Tap \textbf{Next}.

![Image of Settings screen with modem selection]

6. Enter the number that should be dialed to connect to your ISP. Include any special digits such as “*” or “#”. See “Establishing Dialing Rules for Modems,” page 34, for more information.
7. Enter your ISP user name and password, and your domain, if necessary.

![Image of Settings screen with username and password fields]

8. To change connection speed or other connection options, tap \textbf{Advanced}.

\textbf{NOTE}: \textit{You should not need to change any of the settings on the Advanced screen.}

9. Tap \textbf{Finish} to complete this wizard.
To set up a work modem connection:
1. Tap and then Settings.
2. Tap the Connections tab and then the Connections icon.
4. Complete the setup as described on the previous page.

Connecting to your ISP

Open Messaging, Pocket Internet Explorer, or MSN Messenger. Your iQue M3 automatically begins connecting. After you connect, you can send and receive e-mail, browse Web pages, and send and receive instant messages.

To connect manually to your ISP:
1. Tap , Settings, the Connections tab, and the Connections icon.
2. Under My ISP or My Work Network, tap Manage Existing Connections.
3. Tap and hold on the applicable dial-up settings and select Connect. To delete the connection, tap Delete.

Establishing Dialing Rules for Modems

To create dialing rules for your modem connection:
1. Tap Settings, the Connections tab, and then Connections.
2. Tap the Advanced tab and then tap Dialing Rules.
3. To enable dialing rules, tap to check the box next to Use dialing rules. Then tap OK to acknowledge the message that appears.
4. Tap to select Home or Work (the dialing rules apply to your ISP or your Work connection, respectively).
5. Tap **Edit** to configure your dialing rules.

6. Enter a name for the dialing profile (if necessary), the country code, and the area code. Tap to disable call waiting. If you have a pulse phone, tap **Pulse dialing** (most phones have tone dialing).

7. Tap **Dialing Patterns** to change how dialing occurs.

8. Enter how local, long distance, and international calls should be dialed. You can use the following abbreviations: E/e represents country code, F/f represents area code, G/g represents a seven-digit phone number. Tap **OK** to save your changes.
Connecting to a Network
Use a network card to connect to any private network, such as a corporate network that you use at work.

Setting up a VPN
A VPN connection helps you securely connect to a server, such as a corporate network, via the Internet. Ask your network administrator for your user name, password, domain name, TCP/IP settings, and host name or IP address of the VPN server.

To set up a VPN connection:
1. Tap 📱, Settings, the Connections tab, and the Connections icon.
2. Under the My Work Network heading, tap Add a new VPN server connection.
3. Enter a name for the connection, a host name or IP address, and the VPN type. Then tap Next. Enter a Host name or IP address.
4. Tap to select whether you want to use a pre-installed certificate or a pre-shared key. Tap Next.
5. Enter your user name and password. If necessary, tap Advanced to enter TCP/IP settings and Server DNS/WINS information.
6. Tap Finish.

Connecting to a VPN Server
Open Inbox, Pocket Internet Explorer, or MSN Messenger. Your iQue M3 automatically begins connecting to the Internet.

To connect manually to a VPN server:
1. From the Connections main window, select Edit My VPN Servers.
2. Tap and hold on your server name and then select Connect. You can also delete your VPN server connection from this menu.
Setting Up a Proxy Server

If your work connection is active during synchronization, your mobile device should download proper proxy settings during synchronization from your PC. If these settings are not on your PC or need to be changed, ask your ISP or network administrator for the proxy server name, server type, port, type of Socks protocol used, and your user name and password.

To set up a proxy server connection:
1. Tap Settings, the Connections tab, and the Connections icon.
2. To create a new connection, under the My Work Network heading, tap Add a new proxy server.
3. Select This network connects to the Internet and This network uses a proxy server.

Enter the name of your Proxy server in the field above. Tap Advanced to enter more settings.

4. In the Proxy server box, enter the proxy server name. For advanced options, select the Advanced button from the Proxy Settings tab. You should get this information from your company's network administrator.

To change existing proxy server settings:
1. Tap Settings, the Connections tab, and the Connections icon.
2. Under My Work Network, tap Edit my proxy server and make any necessary changes.

Setting Up a Wireless Ethernet Connection

To set up a wireless Ethernet connection, you can use a wireless Ethernet card that is compatible with the iQue M3.

To set up a wireless Ethernet connection:
1. Insert the wireless Ethernet card into your device. For instructions on inserting and using the Ethernet card, see the owner’s manual for the card. When properly inserted, a pop-up message appears.
2. Choose whether the installed network card should be used to connect to The Internet or Work. If you tap OK, you automatically accept the default settings for the card and can proceed to step 7 (most home networks allow you to get online immediately). If you need to enter a proxy server, tap Settings and enter the proxy server information as described above.
3. To configure the Network Card, tap \(\text{Settings}, \text{the Connections tab, and then Connections}\)
4. If the network requires a WEP key, a message appears asking you to enter the key.
5. From the \text{IP Address} tab, choose to use a server-assigned IP address or a specific IP address. Enter the IP address if necessary.
6. Tap the \text{Name Servers} tab and enter DNS and WINS settings, if necessary. Then tap \(\text{OK}\).

\text{NOTE: You must remove and reinsert your network card for these settings to take effect.}

7. To view your wireless network connection, tap the \text{Connectivity} icon in the notification area. After your network card has been configured, you will connect immediately.

\textbf{To turn your wireless network connection on or off:}
1. Tap the \text{Connectivity} icon and then tap \text{Turn off flight mode} to turn on your network card.
2. Tap \text{Turn on flight mode} to turn off your network card.

\textbf{Exceptions for Work URLs}

Some companies use periods in their intranet URLs (for example, intranet.companyname.com). If you attempt to connect to one of these URLs, Pocket Internet Explorer searches for the Web site in the Internet rather than the company’s intranet. To connect to such intranet URLs, they need to be entered as Work URL exceptions.

\textbf{To create an exception for a work URL:}
1. Tap \(\text{Settings}, \text{the Connections tab, and the Connections icon}.\)
2. From the \text{Advanced} tab, tap \text{Exceptions}.
3. Tap \text{Add new URL}... to add a new exception. Enter a text string and tap \(\text{OK}\).

Enter the URL in the field and tap \text{OK}.
Exchanging Data with Mobile Devices

Your iQue M3 can connect to other handheld devices using Infrared (IR) technology. After you connect, you can “beam” your contact files, appointments, notes, and many other types of files easily, without cords and cables. Beaming means sending data from one device to another.

Beaming Data with IR

Using IR, you can send files from Calendar, Contacts, Tasks, File Explorer, Pocket Word, and Pocket Excel. From within any of these applications, you can simply tap Tools and then Beam to beam a file to another device. You can also tap and hold on a file name and select Beam from the drop-down menu. Make sure that the Infrared ports are lined up and that there are no objects between them.

Your iQue M3 automatically receives all incoming Infrared (IR) beams and asks you whether you wish to accept those beams, with the exception of some older devices. To receive beams from older devices, such as a Pocket PC 2000 or H/PC device, you must tell your iQue M3 to scan for incoming beams.

To change beam settings:
1. Tap Settings, the Connections tab, and Beam.
2. Uncheck the Receive all incoming beams checkbox if you do not want to receive incoming beams.

To receive beams from older devices (Pocket PC 2000 or H/PC):
1. Tap Settings, the Connections tab, and then Beam.
2. Tap the Receive an infrared beam link at the bottom of the page.
CHAPTER 6: CUSTOMIZING YOUR iQUE M3

You can customize your iQue M3 by adjusting personal settings and system settings. Personal settings allow you to change things like sounds, passwords, and menus. System settings allow you to adjust backlight and power settings, change system time, change memory settings, and more. Adjusting system settings can also help save battery power.

Changing Personal Settings

To customize Buttons:
1. Tap ☰️ Settings, and the Buttons icon.
2. Tap the button in the list you want to change. Then choose the program from the Assign a program drop-down menu that you want to open when you press that button.
3. Tap the Up/Down Control tab to change the way your Up and Down buttons (Scroll buttons on the front of your iQue M3) operate.
4. Tap the Advanced tab to change the way the Que button operates.

To customize the Input Panel:
1. Tap ☰️ Settings, and the Input icon.
2. Choose an input method from the drop-down menu. Then tap Options, or tap to configure settings (for the Keyboard).
3. Tap the Word Completion tab to turn word completion on or off and configure settings.
4. Tap the Options tab to change more settings, including voice recording format and zoom options.
To place programs in the Start Menu:
1. Tap 📋 Settings, and the Menus icon.
2. Tap to place a checkmark next to the programs you want to appear in your Start menu. If you do not want a program to appear, uncheck the box. Unchecked programs appear under 📋 Programs.
3. Tap the New Menu tab and then check the box next to Turn on New button menu to activate the New menu (found on the Today page at the lower left corner of the screen). Tap to check or uncheck programs you want to appear in this menu.

To set Owner Information:
1. Tap 📋 Settings, and the Owner Information icon.
2. Tap each field and enter your personal information.
3. Tap the Notes tab and enter any notes you want to display.
4. Tap the Options tab and check the boxes if you want to display your personal information or notes each time you turn on your iQue M3.
To set a password:
1. Tap 

2. To activate a password, tap to check the box next to Prompt if device unused for. Then, from the drop-down menu, select how long you want your iQue M3 to sit idle before it asks for a password.
3. Choose a password type from the Password type drop-down menu.
4. Enter the password. If you chose Simple 4 digit as the password type, you must enter a four-digit number. If you chose Strong alphanumeric, reenter the password in the Confirm field.
5. Tap the Hint tab and enter a hint to help you remember your password.
6. Tap . Then tap Yes to confirm your changes.

A simple password, a strong password, and a password hint

To change or delete a password:
1. Tap 

2. Enter your password.
3. Change your password to a new password. To stop using a password, uncheck the box next to Prompt if device unused for.

To change sounds:
1. Tap 

2. Tap to check boxes for the sounds you want to hear and uncheck boxes for the sounds you want to silence.

NOTE: You can adjust the volume from the Today page by tapping and dragging the slider bar up or down.

To change notifications:
1. Tap 

2. Tap the Event drop-down menu to choose an event.
3. Tap to check or uncheck the Play sound box. Tap to check or uncheck other notification settings as needed.
To change the Today screen theme:
1. Tap \( \text{\textit{Settings}}, \) and the \( \text{\textit{Today}} \) icon.
2. Select a theme from the list that appears. To use a picture as the background, check the box next to \textit{Use this picture as the background}. Then tap \textit{Browse} to select a picture on your iQue M3.
3. Tap the \textit{Items} tab and check or uncheck boxes to choose what appears on the Today screen. Tap an item and then tap \textit{Move Up} or \textit{Move Down} to change the order in which items appear.
4. Tap Intellidate, QuickLaunch, GPS Info, Calendar, or Tasks and then tap \textit{Options} to specify how these items appear on the \textit{Today} screen.
5. If you want the iQue M3 to display the Today screen when turned on, tap \textit{Today timeout}. Then choose a time from the drop-down menu (the Today screen appears when the iQue M3 is turned on after sitting idle for this amount of time).

Changing the appearance of the Today screen.

Viewing iQue M3 Information

You can view detailed information about your iQue M3 from two system settings programs: About and Assets. About displays information about the Windows Mobile™ software and copyrights on your iQue M3 and allows you to change the device name for use with ActiveSync. Assets displays detailed information about the iQue M3 hardware and included Garmin software.

To view About or Assets:
1. Tap \( \text{\textit{Settings}}, \) and the \textit{System} tab.
2. Tap \textit{About} or \textit{Assets}. To view information in About, tap each tab. To view information within Assets, expand each topic by tapping \( \text{\textit{+}} \).

To change the device name:
1. Tap \( \text{\textit{Settings}}, \) and the \textit{System} tab.
2. Tap \textit{About} and then the \textit{Device ID} tab. Then enter a new name in the \textit{Device name} field and tap \( \text{\textit{OK}} \).
You can also view information about device Certificates from system settings. A certificate is a file that helps you identify yourself to secure networks (personal certificates) or helps you identify servers you may connect to (root certificates).

**To view certificates:**
1. Tap 📜 Settings, and the System tab.
2. Tap the Certificates icon. View your personal certificates. Tap the Root tab to view root certificates.
3. To delete a certificate, tap and hold on a certificate in the list and choose Delete.

## Configuring Backlight and Power Settings

Changing Backlight and Power settings properly can help you save battery life! If you keep the backlight or your iQue M3 on for long periods of time, you will use up battery power very quickly. Remember to turn off the backlight and your iQue M3 when you are not using them to save battery power.

**To change Backlight settings:**
1. Tap 📜 Settings, the System tab, and the Backlight icon.
2. From the Battery Power tab, tap the drop down menu to select how much time should pass before the backlight turns off when using battery power.
3. Tap the External Power tab. Tap to check the box if you want the backlight to turn off when the device is run by external power (like your automotive cradle or your desk cradle). Tap to select how much time you want to elapse before the backlight turns off.
4. Tap the Brightness tab. Choose the brightness level you want the backlight to have.

![Changing Backlight settings](image)

**To change Power settings:**
1. From the Backlight screen, tap the blue Power link at the bottom of the screen.

OR

- Tap 📜 Settings, the System tab, and then the Power icon.
2. View the current battery power remaining.
3. Tap the Wireless tab to turn wireless signals on or off.
4. Tap the Advanced tab to turn off the device if idle. Choose a time from the drop-down menu. After the iQue M3 is idle for this amount of time, the unit will turn off automatically.
5. Tap the Sleep tab to wake up the device by pressing buttons or to enable GPS Standby mode.
Changing System Settings

To change bass boost settings:
1. Tap Settings, and the System tab.
2. Tap the Audio icon. Drag the slider to adjust bass boost settings.

To change microphone settings:
1. Tap Settings, the System tab and then the Audio icon.
2. Tap the Microphone tab. Then tap to configure the microphone gain for various situations. If you choose a custom gain setting, drag the slider at the bottom of the screen to adjust the gain.

To change the time:
1. Tap Settings, the System tab, and the Clock & Alarms icon.
2. Tap to choose whether you want to set Home time or Visiting time.
3. Choose a time zone from the drop-down menu.
4. To change the time, tap to highlight the hour showing in the Time field. Tap the up arrow or down arrow to change the hour. Tap to change minutes, seconds, and AM or PM in the same way.
5. Tap the arrow next to the date to choose a date from the calendar. Or, tap each number in the date and enter new information using the Input Panel.
6. Tap OK.

NOTE: You can also change the time by tapping the Date and Time displayed on the Today screen.

To set an alarm:
1. Tap Settings, the System tab, and the Clock & Alarms icon.
2. Tap the Alarms tab.
3. Tap to check the first box to set an alarm. Next to the box, tap < Description > and enter a name for the alarm.
4. To select a day of the week for the alarm to go off, tap a letter underneath the alarm name. Tap multiple letters to select multiple days. Tap a selected letter to remove that day.
5. Tap the time to set the time you want the alarm to go off. Tap the bell to customize the way the alarm goes off.
6. Repeat steps 3-6 for each new alarm you want to set.
CUSTOMIZING > CHANGING SYSTEM SETTINGS

To view memory available and change how memory is allocated:
1. Tap Settings, the System tab, and the Memory icon.
2. Drag the slider to adjust how much memory is allocated to Storage and Programs.
3. Tap the Storage Card tab to view how much memory is free in Safe Storage and on your Secure Digital (SD) card.
4. Tap the Running Programs tab to view the programs that are running. Tap a program and then tap Activate to view the program or tap Stop to close the program. Tap Stop All to close all running programs.

Configuring Regional Settings

This control panel allows you to change how data appears on your iQue M3, such as currency, times, dates, and numbers. Pocket PC comes pre-installed with many international regional setting profiles, but all can be configured to your needs.

To change Regional Settings:
1. Tap Settings, the System tab, and the Regional Settings icon.
2. Tap the drop-down menu to select the language you want to appear on your iQue M3.

NOTE: This language setting does not affect icon or program names; it only changes dates, numbers, and other data you enter.

3. Tap the Number, Currency, Time, and Date tabs to change the way these things appear on your iQue M3. You may need to reset your iQue M3 for these settings to take effect.

Removing Programs

Use Remove Programs to uninstall programs from your iQue M3 that you have installed into storage memory. Note that you cannot uninstall programs that came included with your iQue M3.

To remove programs:
1. Tap Settings, the System tab, and the Remove Programs icon.
2. Tap the program in the list that you want to remove. Then tap Remove. Tap Yes when the warning message appears.
Changing Screen Settings

Occasionally, your touch display might not respond correctly to stylus or finger taps. If this happens, try aligning the screen.

**To align the screen:**
1. Tap 📛, Settings, the System tab, and the Screen icon.
2. Tap the Align Screen button.
3. Follow the instructions on the screen.

![Aligning the screen](image)

You can change the screen orientation on your iQue M3 from portrait mode (default) to landscape mode.

**To change screen orientation:**
1. Tap 📛, Settings, the System tab and the Screen icon.
2. Tap to change the screen to Landscape (left or right-handed) or Portrait mode.

*NOTE: Some programs work best in Portrait mode. If you have trouble using a program, try switching to Portrait mode.*

ClearType controls how fonts appear on your iQue M3 screen. You can adjust ClearType with the ClearType Tuner.

**To enable/disable ClearType:**
1. Tap 📛, Settings, the System tab, and the Screen icon.
2. Tap the ClearType tab. Then check or uncheck the box to enable or disable ClearType.

**To use the ClearType tuner:**
1. Tap 📛, Settings, the System tab, and the ClearType Tuner icon.
2. Drag the slider until the text looks clear. Then tap ✓.

**To change screen text size:**
1. Tap 📛, Settings, the System tab and the Screen icon.
2. Tap the Text Size tab. Then drag the slider to increase or decrease the text size that appears in most programs.
About QueGPS

QueGPS displays the following information:

• The current date and time.
• Your current position, speed, elevation, and estimated accuracy of position.
• GPS status, number of satellite signals received, and signal strength.

The circular graphic in the center of the page displays the position of each satellite currently in your area. Each satellite is represented by a number (from 1–31), and the numbers appear on the graphic to show the positions of the satellites. You can also see the current positions of the sun and moon.

You can change the orientation of the circular graphic to North Up (North is at the top of the screen) or Track Up (your direction of travel is at the top of the screen). Tap Menu and choose an orientation.

Below the graphic are a number of bars, which represent the strength of each satellite signal being received. The number below each bar corresponds to the satellite sending the signal. No bar indicates that the GPS receiver is not receiving a signal from this satellite. A hollow bar indicates that the GPS receiver is gathering data from this satellite. A solid bar means that the GPS receiver has received data from this satellite and can use it for navigation.

Troubleshooting

If you have trouble acquiring satellites with your iQue M3, try these tips and suggestions:

• Make sure the GPS antenna is raised and is parallel to the horizon.
• Make sure you are in an open area that is unobstructed by tall buildings or trees.
• Make sure you have given the iQue M3 enough time to initialize: it may take several minutes.
• Try turning the iQue M3 off and then back on.
• If you have moved a long distance since you last used the iQue M3, or if initializing takes a long time, use the QueGPS page to change your location, as described below.

To change your location:

1. With the iQue M3 turned on and the GPS antenna open, tap the System Status icon at the top of the page.
2. Tap the GPS Status icon ("Acquiring Satellites") to open QueGPS.
3. Tap Menu. Then tap New Location.
4. Use the Pan Toolbar at the top of the page to find your approximate position on the map. For more information, refer to the Quick Reference Guide or the Help files in QueNav.
5. Tap the map to place the map pointer at your approximate position.
6. Tap Select.
Learning About GPS and WAAS
For more information about GPS and WAAS, visit our Web site at http://www.garmin.com/aboutGPS.

Caring for the iQue M3
The iQue M3 case is constructed of high quality materials and does not require user maintenance except cleaning.

Clean the outer casing (except for the screen) using a cloth dampened with a mild detergent solution. Wipe the casing dry. Avoid chemical cleaners and solvents that may damage plastic components.

Clean the screen with a soft, clean, lint-free cloth. If necessary, you may use water, isopropyl alcohol, or eyeglass cleaner. Apply the liquid to the cloth and then gently wipe the screen.

Storing the iQue M3
Do not store the iQue M3 where prolonged exposure to temperature extremes may occur (such as in the trunk of a car), as permanent damage may result. The unit retains user information, such as waypoints and routes, in memory without external power. As a precaution, back up important user data by recording it manually or by downloading it to a PC (transferring it to MapSource).
Specifications

Physical
Size: 128 mm x 72 mm x 19 mm (5.04 in x 2.83 in x 0.75 in)
Weight: 166 grams
Display: 3.5” QVGA transflective TFT display, 64K colors
Antenna: Built-in patch antenna

Performance
GPS Receiver: Integrated 12-channel GPS receiver
Acquisition times:
  Warm: Approximately 15 sec.
  Cold: Approximately 45 sec.
  AutoLocate®: Approximately 2 min.
Update rate: 1/sec. continuous
GPS Accuracy: < 15 meters¹, 95% typical
DGPS (WAAS) Accuracy: < 3 meters, 95% typical
Velocity Accuracy: 0.05 meter/sec steady state
Interfaces: USB, Infrared

Power
Source: Non-removable 1250 mAh lithium polymer rechargeable battery
Battery Life:
  Active: Normal operation, no backlight, GPS off: up to 19 hours
  Normal operation, no backlight, GPS on: up to 11 hours
  Normal operation, half backlight, GPS on: up to 5.5 hours
  Normal operation, no backlight, GPS off, WMA playback: up to 15 hours
Sleep/Suspend: Approx. 1 month
Shutdown: Retains memory for a minimum of 72 hours after low battery shutdown

Internal System
Embedded Capabilities: 12-channel GPS receiver, IrDA
Audio Hardware: Integrated speaker, microphone, 3.5 mm stereo headphone jack
Processor: 312 MHz Intel® PXA271 Xscale™ processor, dedicated 48 MHz ARM7 GPS coprocessor
Internal Memory: 64 MB RAM, 32 MB ROM (2 MB safe storage available)
Expandable Memory: SDIO/MMC
Software License Agreement

THIS END-USER LICENSE AGREEMENT (“LICENSE”) IS A LEGAL AGREEMENT BETWEEN YOU AND GARMIN LTD. (“GARMIN”). ALL GARMIN SOFTWARE AND THIRD PARTY SOFTWARE THAT IS (i) INSTALLED IN THE PRODUCT AND/OR (ii)Recorded in media attached to the package or included in the package of the product (except as may be provided pursuant to other third party end-user license agreements) shall be referred to herein as the “SOFTWARE.” THE SOFTWARE IS OWNED BY, OR LICENSED TO, GARMIN LTD. (“GARMIN”) AND IS PROTECTED UNDER COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES. THE SOFTWARE IS LICENSED, NOT SOLD. THIS SOFTWARE IS PROVIDED UNDER THE FOLLOWING LICENSE WHICH DEFINES WHAT YOU MAY DO WITH THE PRODUCT AND CONTAINS LIMITATIONS ON WARRANTIES AND/OR REMEDIES.

IMPORTANT: CAREFULLY READ THIS LICENSE BEFORE USING THIS PRODUCT. INSTALLING, COPYING, OR OTHERWISE USING THIS PRODUCT INDICATES YOUR ACKNOWLEDGMENT THAT YOU HAVE READ THIS LICENSE AND AGREE TO ITS TERMS. IF YOU DO NOT AGREE, RETURN THE COMPLETE PRODUCT TO: GARMIN INTERNATIONAL, INC. CUSTOMER SERVICE, 1200 EAST 151ST STREET, OLATHE, KS 66062; OR GARMIN (EUROPE) LTD., UNIT 5, THE QUADRANGLE, ABBEY PARK INDUSTRIAL ESTATE, ROMSEY, SO51, 9DL, U.K.; OR GARMIN CORPORATION, NO. 68 JANGSHU 2ND ROAD, SHIJR, TAIPEI COUNTY, TAIWAN; WITHIN 10 DAYS OF THE DATE YOU ACQUIRED IT FOR A FULL REFUND.

1. LICENSE: Garmin (“we” or “us”) provides you with storage media containing the Software, which may also include digital cartographic data, “online” or electronic documentation, and printed materials (together called the “Product”), and grants you a limited non-exclusive license to use the Product in accordance with the terms of this License Agreement. The copyright and all other rights to the Product shall remain with us (and our licensors, as applicable). You must reproduce any copyright or other notice marked on the Product on all copies you make.

2. YOU MAY:
   a) install and use one copy of the Product on a single computer or network. This copy is to be used by only a single user at a time. If you wish to use the Product for more users, you will need an additional license for each user.
   b) make one copy of the Product for archive or backup purposes.
   c) use a copy of the Product on a home or portable computer if that copy is never loaded at the same time that it is loaded on your primary computer.
   d) transfer the Product to someone else only if you assign all of your rights under this License, cease all use of the Product, erase or destroy any copy (including the hard disk copy) made in support of your use of the Product, and ensure that the other person agrees IN WRITING to the terms of this License.

3. YOU MUST NOT:
   a) make copies of, or provide access to, the Product except as expressly permitted in Section 2 of this License.
   b) translate, reverse engineer, decompile, or disassemble the Product except to the extent the foregoing restriction is expressly prohibited by applicable law.
   c) rent, lease, loan, sub-license, distribute, assign, or transfer the Product or any unlock code for the Product except as set out in Section 2 (d) above.
   d) modify the Product or merge all or any part of the Product with another program.
   e) use the Product for any unlawful purpose or in any illegal manner.
4. **TERM:** This License shall continue for as long as you use the Product. However, this License will terminate automatically without notice from Garmin if you fail to comply with any of its terms or conditions. You must agree, upon termination, to destroy all copies of the Product. The Limitations of Warranties and Liability set out in the next paragraphs shall continue in force even after any termination.

5. **LIMITATION OF WARRANTIES AND LIABILITY:** THE PRODUCT IS PROVIDED ON AN “AS IS” BASIS, WITHOUT ANY WARRANTIES OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR ANY WARRANTY ARISING BY LAW, STATUTE, USAGE OF TRADE, OR COURSE OF DEALING. YOU ASSUME ALL RESPONSIBILITY AND RISK FOR THE USE OF THIS PRODUCT, AND GARMIN DISCLAIMS ALL LIABILITY FOR ANY LOSS, INJURY, OR DAMAGE RESULTING FROM USE OF THIS PRODUCT, WHETHER DIRECT OR INDIRECT, AND WHETHER OR NOT GARMIN HAS BEEN ADVISED OF OR HAS KNOWLEDGE OF THE POSSIBILITY OF SUCH LOSS, INJURY, OR DAMAGE. IN NO EVENT SHALL GARMIN HAVE ANY LIABILITY TO YOU OR ANY OTHER PERSON OR ENTITY FOR ANY COMPENSATORY, INDIRECT, INCIDENTAL, SPECIAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES WHATSOEVER, INCLUDING, BUT NOT LIMITED TO, LOSS OF REVENUE OR PROFIT, LOST OR DAMAGED DATA, OR OTHER COMMERCIAL OR ECONOMIC LOSS, EVEN IF WE HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR THEY ARE FORESEEABLE. WE ARE ALSO NOT RESPONSIBLE FOR CLAIMS BY A THIRD PARTY. OUR MAXIMUM AGGREGATE LIABILITY TO YOU SHALL NOT EXCEED THE AMOUNT PAID BY YOU FOR THE PRODUCT. THE LIMITATIONS IN THIS SECTION SHALL APPLY WHETHER OR NOT THE ALLEGED BREACH OR DEFAULT IS A BREACH OF A FUNDAMENTAL CONDITION OR TERM OR A FUNDAMENTAL BREACH. Some states do not allow the exclusion of incidental or consequential damages or the limitation of duration of an implied warranty so the above limitations may not apply to you.

IT IS YOUR RESPONSIBILITY TO USE THIS PRODUCT PRUDENTLY AND TO VISUALLY VERIFY STREETS, ROADS, ROAD SIGNS, AND DIRECTIONS. THIS PRODUCT IS INTENDED TO BE USED ONLY AS A TRAVEL AID AND SHOULD NOT BE USED FOR ANY PURPOSE REQUIRING PRECISE MEASUREMENT OF DIRECTION, DISTANCE, OR LOCATION. DO NOT ATTEMPT TO ENTER INFORMATION INTO THE PRODUCT, OR CONTROL THE PRODUCT, WHILE OPERATING A VEHICLE.

6. **U.S. GOVERNMENT RESTRICTED RIGHTS.** (I) THE PRODUCT and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the United States Government is subject to restrictions as set forth in subparagraph (c)(1) and (2) of the Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. Manufacturer/Contractor is Garmin International, Inc., 1200 East 151st Street, Olathe, KS 66062. (II) All Garmin technical data and computer software is commercial in nature and developed solely at private expense. Software is delivered as Commercial Computer Software as defined in DFARS 252.227-7014 (June 1995) or as a commercial item as defined in FAR 2.101(a) and as such is provided with only such rights as are provided in Garmin’s standard commercial license for such software. Technical data is provided with limited rights only as provided in DFARS 252.227-7015 (Nov. 1995) or FAR 52.227-15 (June 1987), whichever is applicable.

7. **EXPORT CONTROLS:** You agree not to export or re-export the Product to any country in violation of the export control laws of the United States of America.

8. **GARMIN LICENSORS:** With respect to Third Party Software contained in the Product, the provisions of this License shall inure to the benefit of the licensors to Garmin of third party software contained in the Product. Such licensors shall be third party beneficiaries hereof, and shall have the right to enforce any and all rights and claims arising hereunder with respect to such third party software, including the right to bring an action directly against you, in the event of a breach by you of your obligations hereunder.

9. **GENERAL:** This License is the entire agreement between us, superseding any other agreement or discussions, oral or written, and may not be changed except by a signed agreement. This License shall be governed by and construed in accordance with the laws of the State of Kansas, United States of America. If any provision of this License is declared by a court of competent jurisdiction to be invalid, illegal, or unenforceable, such a provision shall be severed from the License and the other provisions shall remain in full force and effect.
# Index

<table>
<thead>
<tr>
<th>A</th>
<th>About Your iQue M3</th>
<th>43</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ActiveSync</td>
<td></td>
</tr>
<tr>
<td></td>
<td>backing up files</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>moving files and folders</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>restoring files</td>
<td>13</td>
</tr>
<tr>
<td>Alarms</td>
<td>setting</td>
<td>45</td>
</tr>
<tr>
<td>Appointments</td>
<td>creating</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>meeting requests</td>
<td>16</td>
</tr>
<tr>
<td>Assets</td>
<td>43</td>
<td></td>
</tr>
<tr>
<td>Audio Settings</td>
<td>45</td>
<td></td>
</tr>
<tr>
<td>B</td>
<td>Backing Up Files</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Backlight</td>
<td>44</td>
</tr>
<tr>
<td></td>
<td>Bass Boost</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Beaming with Infrared</td>
<td>39</td>
</tr>
<tr>
<td>Block Recognizer</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>Buttons</td>
<td>customizing</td>
<td>40</td>
</tr>
<tr>
<td>C</td>
<td>Calendar</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>meeting requests</td>
<td>16</td>
</tr>
<tr>
<td></td>
<td>recording a message</td>
<td>22</td>
</tr>
<tr>
<td>Changing Settings</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>Connecting to an ISP</td>
<td>33</td>
<td></td>
</tr>
<tr>
<td>Contacts</td>
<td>creating</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>finding</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>recording a message</td>
<td>22</td>
</tr>
<tr>
<td>Currency</td>
<td>changing</td>
<td>46</td>
</tr>
<tr>
<td>Customizing Your iQue M3</td>
<td>40</td>
<td></td>
</tr>
<tr>
<td>D</td>
<td>Date</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>changing format</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Dates</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>Device Name</td>
<td>changing</td>
</tr>
<tr>
<td></td>
<td>Drawing</td>
<td>22</td>
</tr>
<tr>
<td>F</td>
<td>File Explorer</td>
<td>8</td>
</tr>
<tr>
<td></td>
<td>Find Files and Folders</td>
<td>8</td>
</tr>
<tr>
<td>G</td>
<td>GPS Satellites</td>
<td>48</td>
</tr>
<tr>
<td>I</td>
<td>Infrared</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Input Panel</td>
<td>customizing</td>
</tr>
<tr>
<td></td>
<td>Internet</td>
<td>connecting by modem</td>
</tr>
<tr>
<td></td>
<td>opening</td>
<td>4</td>
</tr>
<tr>
<td></td>
<td>removing</td>
<td>11</td>
</tr>
<tr>
<td>Q</td>
<td>QueGPS</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>new location</td>
<td>48</td>
</tr>
<tr>
<td>R</td>
<td>Recording Messages</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Regional Settings</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Removing Programs</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Restoring Files</td>
<td>13</td>
</tr>
<tr>
<td>S</td>
<td>Satellite Signals</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>new location</td>
<td>48</td>
</tr>
<tr>
<td></td>
<td>Security</td>
<td>setting a password</td>
</tr>
<tr>
<td></td>
<td>Signatures</td>
<td>18</td>
</tr>
<tr>
<td></td>
<td>Sounds</td>
<td>bass boost</td>
</tr>
<tr>
<td></td>
<td>microphone</td>
<td>45</td>
</tr>
<tr>
<td>Start Menu</td>
<td>adding programs</td>
<td>12, 41</td>
</tr>
<tr>
<td></td>
<td>Stylus</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Synchronizing</td>
<td>e-mail messages</td>
</tr>
<tr>
<td></td>
<td>limiting</td>
<td>9</td>
</tr>
<tr>
<td></td>
<td>scheduling</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>with exchange server</td>
<td>14</td>
</tr>
<tr>
<td></td>
<td>with infrared</td>
<td>14</td>
</tr>
<tr>
<td>T</td>
<td>Tap and Hold</td>
<td>2</td>
</tr>
<tr>
<td></td>
<td>Tasks</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>creating</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>recording a message</td>
<td>22</td>
</tr>
<tr>
<td></td>
<td>Time</td>
<td>changing</td>
</tr>
<tr>
<td></td>
<td>changing format</td>
<td>46</td>
</tr>
<tr>
<td>Today Screen</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>changing wallpaper</td>
<td>31</td>
</tr>
<tr>
<td>Today screen</td>
<td>changing</td>
<td>43</td>
</tr>
<tr>
<td></td>
<td>Transcriber</td>
<td>7</td>
</tr>
<tr>
<td>W</td>
<td>WAAS</td>
<td>49</td>
</tr>
<tr>
<td></td>
<td>Windows Media Player for Pocket PC</td>
<td>30</td>
</tr>
<tr>
<td>Writing on the Screen</td>
<td>8</td>
<td></td>
</tr>
</tbody>
</table>